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1 Safety guidelines

Programmable logic controllers (PLCs), operating/monitoring devices (industrial PCs, HMI) have
been designed, developed and manufactured for conventional use in industrial environments. They
were not designed, developed and manufactured for any use involving serious risks or hazards that
could lead to death, injury, serious physical damage or loss of any kind without the implementation
of exceptionally stringent safety precautions. In particular, such risks and hazards include the use of
these devices to monitor nuclear reactions in nuclear power plants, their use in flight control or flight
safety systems as well as in the control of mass transportation systems, medical life support systems
or weapons systems.

1.1 Policies and procedures

Electronic devices are never completely failsafe. If the programmable control system, operating/
monitoring device or power supply fails, the user is responsible for ensuring that other connected
devices, e.g. motors, are brought to a secure state.

When using programmable logic controllers or operating/monitoring devices as control systems
together with a soft PLC, safety precautions relevant to industrial control systems must be observed
in accordance with applicable national and international regulations. The same applies for all other
devices connected to the system, such as drives.

All tasks such as the installation, commissioning and servicing of devices are only permitted to be
carried out by qualified personnel. Qualified personnel are those familiar with the transport, mounting,
installation, commissioning and operation of devices who also have the appropriate qualifications
(e.g. IEC 60364). National accident prevention regulations must be observed.

The safety notices, information on connection conditions (type plate and documentation) and limit
values specified in the technical data are to be read carefully before installation and commissioning
and must always be observed.

1.2  Installation guidelines

« These devices are not ready for use upon delivery and must be installed and wired according to the
specifications in this documentation in order for the EMC limit values to apply.

« Installation must be performed according to this documentation using suitable equipment and
tools.

+ Devices are only permitted to be installed by qualified personnel without voltage applied. Before
installation, voltage to the control cabinet must be switched off and prevented from being switched
on again.

+ General safety guidelines and national accident prevention regulations must be observed.

+ Electrical installation must be carried out in accordance with applicable guidelines (e.g. line cross
sections, fuses, protective ground connections).

1.3  Viruses and dangerous programs

This system is subject to potential risk each time data is exchanged or software is installed from a data
medium (e.g. diskette, CD-ROM, USB flash drive, etc.), a network connection or the Internet. The user is
responsible for assessing these dangers, implementing preventive measures such as virus protection
programs, firewalls, etc. and making sure that software is only obtained from trusted sources.

1.4  Organization of safety notices
Safety notices in this manual are organized as follows:

Safety notice Description
[Danger!] Disregarding these safety guidelines and notices can be life-threatening.
: Disregarding these safety guidelines and notices can result in severe injury or
|
substantial damage to property.
Disregarding these safety guidelines and notices can result in injury or damage to
: property.

This information is important for preventing errors.
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2 TdControlPanel

At switch-on a project starts allowing to verify the machine
general status, date/system hour, related IP address,
SoftPLC execution in background.

Using a VNC client you can view from your PC what is displayed on the PLC / HMI. Starting a browser
with active Java service it is possibile to test if the device Webserver function is active. For this function
it is necessary to use Internet Explorer.

Press “Td Control Panel,” to access the device control
panel and verify/configure all the services and projects
to be launched at starting. It is possible also to configure
the standby time for the backlighting switch off and the
buzzer at display pressure.

The following paragraphs describe each function of the TdControlPanel windows.
NB: Pictures show device standard configuration.

2.a WIN EXPLORER

From this window it is possible to choose a set of options

to start Windows CE and execute TDControlPanel.

« The first option starts Windows CE with desktop.

« The second option allows TDControlPanel starting if ,
during the switch on , the key “Stop” is keep pressed @.
Enabling the third option it is possible to set a
protection password to avoid that unauthorized users,
keeping pressed “STOP” @, access TDControlPanel
settings.

“START WINDOWS DESKTOP” allows to start “Explorer.exe” to access Windows CE desktop.

2.b HMI_MOVICON
From this window it is possible to select which Movicon 11
services/programs execute automatically at starting.

The functions of the Movicon scada are available in all
HMI and in “WEB" version PL500 (PL500-335-1AD-WEB)

“START” activates manually the Movicon project (and the file upload service)

2.c PLCLOGICLAB
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From this window it is possible to enable/disable the
SoftPLC execution at starting. Selecting “RUN console
DEBUG", during the SoftPLC execution, the Debug window
will be filled with real-time system events to verify possible
anomalies.

NB: this function requires many device resources. It is
suggested to keep it active only if there are problems
during the software development. Disable this function at
the end of the development phase.

“START” activates manually the SoftPLC project (and any debug window).

2.d

2.e

2.f

LAN ETH1

BACKLIGHT - BUZZER

WINVNC

From this window it is possible to modify the device
network configuration parameters. Any modification will
require a restart to be applied.

NB: to transfer the SoftPLC program and Movicon on the
device, it must have a fixed address. It is not possible to
operate in DHCP.

The HMI default IP address is 192.168.0.100
The PL500 default IP address is 192.168.0.99

From this window it is possible to configure backlighting
and buzzer parameters. Enabling “Always ON” the
backlighting keeps always active. Otherwise, enter time
value in seconds on “Backlight ON for..(sec)” to enable the
switching off or the lamp attenuation.

The first two fields allows to select the lamp brightness
percentage (100% = ON, 0%=O0FF) during standard
operation or standby.

“Buzzer frequency” allows to select the buzzer tone
frequency (an higher frequency corresponds to a more
acute tone). Select “Buzzer OFF” to deactivate the buzzer at
touch.

“TEST” keys allow to test selected parameters before saving
the configuration.

From this window it is possible to enable/disable the VNC
remote Desktop service. Press“START VNC” to activate
manually this service. Press “START VNC_CONFIG" to access
VNC configuration window and set the authentication
system or modify access password. NB. Parameter
modification is recommended to expert users, incorrect
parameters modification will cause remote desktop service
malfunctioning. Default password to access remote
Desktop through VNCis “1234".
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29 BACKUP-RESTORE
BACKUP of LogicLab and Movicon projects stored on HMI.

After downloading LogicLab and Movicon projects on HMI
and after setting the HMI for their automatic execution at
each starting, switch off the HMI and restart it keeping the
STOP icon pressed.

TDControlPanel window will be opened

Insert a USB pen (FAT32 formatted) in one of the available
USB ports.

Press BACKUP-RESTORE to access the utility for projects
backup and device configuration

This window allows to select backup options:

PLC_LOGICLAB (RUNTIME PROJECT): for backup of LogicLab project and complete Runtime and
also of the configuration completed in the window PLC_LOGICLAB (accessible from main window
of TDControlPanel)

HMI_MOVICON (PROJECT): for backup of single Movicon project and configuration completed in
the window HMI_MOVICON (accessible from main window of TdControlPanel)

HMI_MOVICON (RUNTIME): backup only for Runtime

TdControlPanel (Configuration): for backup of complete configuration performed within different
utilities accessible from main window of TdControlPanel. *Attention: this backup will include also
the eventual Password for TdControl Panel if it has been set in WIN EXPLORER

LAN (IP CONFIGURATION): for backup of network settings of HMI

BOOT SCREEN: for backup of background image visualized during system start up

Tick all boxes to obtain a complete backup of the settings and software projects stored on the HMI.
This is useful and time-saving when requested to program multiple HMIs for same application.

Press BACKUP TO USB DISK to open USB memory
connected to the device; it will be possible to select
destination folder and name for backup file 8default file
name will be date and time of backup creation)

8- HMI Series - User manual



Press OK to start backup (Hourglass will show up ).

A confirmation popup will advice when process will be
completed. Press OK to close popup, press ESC, then the
device may be switched off.

RESTORE procedure to restore LogicLab and Movicon projects on HMI.

To program a new HMI starting from an existing Backup
keep pressing STOP icon during start up of the device

TDControlPanel window will be opened

Insert the USB pen containg Backup files on one of the
available USB ports.
Press BACKUP-RESTORE

Press RESTORE FROM USB DISK to open USB memory
connected to the HMI and select the chosen backup file

Press OK to start Restore process (Hourglass will show up).
A confirmation popup will advice when process will be
completed. Press OK to close popup, press ESC, then the
device may be switched off.

From now on at each start the HMI will start the projects (and eventually the complete configuration
if selected ) automatically.
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3 LogicLab Suite (only HMI+SoftPLC)

LogicLab Suite is the Pixsys development environment for the programming of PLC series, PL500 and
all Operator panels / PanelPC.

The suite is available for free download within “download area” of the website pixsys.net, no activation
code is required (only registration). Supported by all 32/64bit Windows versions, starting from
Windows XP SP3. Available both in English and Italian version. Once downloaded the setup file on
the computer, start the installation and follow the standard procedure. The program can be activated
through the icon "LogicLab” @ (on desktop) or from the menu “Start” > “PixsysSuite” > “LogicLab”.

3.a Language modification

To modify the visualization language it is
necessary to open options window form the
menu “File” > “Options”, go to “Language”, select
“ITA - italiano” and press “Select”. Confirm with
“OK”, close and re-open LogicLab to enable
the modification.

3.b Create - load a project

Open an exsisting project:

« With LogicLab opened, click on “Open
project” or select one of the last projects
form the list.

« With LogiclLab closed, enter on the project
folder and select (double click) the chosen
file (icon @ and extension “.plcprj”).

Create a new project:

Press “New project”.

Enter the name of the new project and select
the folder where the project files will be stored.
Finally, select the device to be programmed.

Attention: selecting “respect capital/lowercase letters”, a variable which contains a capital letter
will be understood as different from another with the same name but with this letter lowercase. It
is recommended to keep this selection disabled, to avoid any confusion during the drafting of the
program code.

3.c Connection to target

Here below please find the necessary requirements for the correct connection between target (device
to be programmed) and the development environment on PC (LogicLab).

Target requirements:

+ device ON and started
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« configured with static IP address compatible with the network where there is the PC to which it will
connect. By default, the IP address of the HMI is 192.168.0.100, for PL500 is 192.168.0.99, so the PC
must have the same network and class (in this case 192.168.0.XXX) but different physical address
(the last 3 digits of the IP address, with a number between 1 and 255, different from 100). If it is
necessary to modify the IP address of the terminal, refer to the TD Control Panel configuration,
section “LAN ETH1” on par. 2.d.

+ connection with net cable (direct or cross) directly to PC or through a net switch

«  SoftPLC in execution (refer to TD Control Panel configuration, section “PLC LOGICLAB” on par. 2.c).

PC requirements:

« IP address compatible with the network where it is located and with the IP address configured on
the target (see previous points)

+ antivirus/firewall which allows the connection to network devices (normally already correctly
configured)

+ LogicLab configured for the connection to the target to be programmed: menu “On Line” > “Select
communication” , on the window that opens press “Properties” and than enter the target IP on “IP
Address”, keeping all the rest unaltered. In case of very slow networks or of a network configuration
with different switches, it is possibile to increase the “Timeout” value (expressed in mS).

The image represents default configuration

Confirm all windows pressing “OK” and save through  or from the menu “file” > “SaveProject”.

To verify the correct LogicLab and Target configurations, it is possible to make the connection pressing
¥ or form the menu “On Line” > “Connect”. If the connection is correctly done, the status bar at the
lower right side will visualize “CONNECTED” and “NO CODE” (to indicate that the target is connected
and has no code in it) or “DIFF CODE” (to indicate that the code which is being visualized does not
correspond to those who lies in the target).

3d Compiling and downloading the code

Once entered the project code it is necessary to verify eventual errors pressing F7, clicking on icon &
or from the menu “Project” > “Fill".

If the compilation is correctly done it is possible to transfer the program to the target pressing F5,
throughicon  or from the menu “On Line” > “Code transferring”.

The status bar will show “CONNECTED” and “SOURCE OK” indicating that the program running on the
target corresponds to that which is visualized on PC.

3.e Watch window

If the program running on the target corresponds to that which is being visualized on PC, the status
bar will show “CONNECTED” and “SOURCE OK” and it is possible to use the window “Watch” to verify
real-time the status of the variables used in the project. To enable the window “Watch”, press CTRL+T
or use “View” > “View tool window"” > “Watch”. To add a variable to the window “Watch”, just drag it inside
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or presstheicon  and select it manually.

From now on, the window “Watch” will visualize
the value of the inserted variable, in real time.

Through it is possible to save, load and add an exsisting watch-list to the list of variables.

To change the visualization format, it is
necessary to select the variable and press .
On the window that opens, select the chosen
format and confirm pressing “OK”.

4 Interfacing Movicon 11 and LogicLab (only HMI+SoftPLC)

NB: Movicon 11.5 or greater.

To execute only once:

Following steps are to be completed on the PC which will be used to develop the projects.

Go to download area of Pixsys website / Movicon section and download “MOVICON 11.6 Update-Ag-
giorna Driver.exe” corresponding to your PC system. Double click to launch the .exe file and follow
instructions.

Do the same procedure also if a Panel PC (TD750-TD850-TD900-TD910-TD920) is used.

Note: with this procedure all PLC system variables and variables created and used in the PLC are
imported.

The creation and the updating of the PLC variables list is done only if the LogicLab program is
compiled without errors and downloaded on the target.

4.a Creating a new Movicon project

Start the software and choose the platform “Windows® X86 / X64" for Panel-PC or “Windows® CE
Platform” for HMI and for “WEB” version of PL500. If the new Movicon project is being created following
the Wizard, at the end it will visualize the driver configuration window, switch to the section “Driver
Configuration” to par. 4.b. If the driver is being installed manually, proceed as follow:

Add the communication driver with a
right click on “Real time DB” and then “new
communication driver”.
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Select “Pixsys” from the manufacturer menu
and then “Pixsys SoftPLC Driver”.

Confirm with “OK” and double click on the
driver just created to open the configuration
window.

4.b Driver configuration

Select “Station” and add a new station pressing
“ADD".

1. Enter source path of the LogicLab project
located on the PC used for development.
This allows to import variables, execute
Movicon in preview mode on own PC,
including communication with SoftPLC,
and perform complete test. Next step is
to indicate IP address of the target HMI/
PC (only after completing development
it will be necessary to enter localhost
address 127.0.0.1 to enable communication
of Movicon project with the softPLC of the
panel itself.

2. Thisfield is self-compiling after entering path as described on previous point. If using an HMI/PL500,
do not modify the self-compiling field; if using a Panel PC (TD750, TD850 etc...) enter the path used
for download of the LogicLab project (default D:\LLExec\ NameMyProjectLogicLab.sym.xml).

3. If Movicon project will be executed on the HMI/PC where the softPLC is also installed, then the IP
address will be 127.0.0.1. If it will be executed on a different HMI/PC, then enter the IP address of the

softPLC.

4. From the section “General” assign a name to the station, ex. “PLC".

Press OK to save settings and exit.

Now it is possible to import the LogicLab
project variabiles on Movicon.

Right click on “SoftPLC Pixsys” and select “Import
PLC database”.
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Press “Read from PLC project”, the list of all
available variables will be provided.

Select variables to be imported and press
“Import”.

NB: If importing an array variable, it will be visualized as a structure carrying the array name.

Single array members will be accessible individually with following syntax NameMyArray:NameMyArray
_Xwhere Xis the array index (starting from 0).

Now variables are available on the Movicon project. If it is necessary to import new variables (to modify
LogicLab project), repeat only the reading and import variables procedure.

4.c Downloading the Movicon code to the target
To downlaod the Movicon Project, use the icon:
1. Select the protocol used to transfer the code:
TCP
2. Insert the target IP address (default for HMI/PLC:
192.168.0.100).
3. If using an HMI/PLC leave the field blank, if using
a Panel-PC insert user (or the user name that is
logged on the Panel-PC target).
4. If using an HMI/PLC leave the field blank, if using
a Panel-PCinsert 123456
5. If using an HMI/PLC insert \NandFlash\MyMovi-
conProjectName)\, if using a Panel-PC insert D:\
MyMoviconProjectName\. In this way Movicon will
create a folder named MyMoviconProjectName
and it will download all the project files into it.
6. Press “Upload Project!"” to download the project
files to the target (press “Yes to All" if a project
was already downloaded to overwrite the old
files).
7. Once the download is completed, press “Start
Deviec Project” to launch the execution of the
project in the target (the project in execution
will be closed and the new one will be executed).
NB: if you need to trasfer different projects/versions to the target, you can change the destination
folder (you must mantain the first part of the address \NandFlash\).
Using the TdControlPanel is possible to select which Movicon 11 project will be executed automatically
at starting (see paragraph 10.b).

5 Simulation of the whole project SoftPLC + SCADA (only
HMI+SoftPLC)

From LogicLab, launch the simulator through the icon = or from menu “Debug” > “Simulation mode”.

On the window which appears, create a new working area indicating the name and the destination

folder (by default it is selected the folder where the project risiede).

At this point, the simulator will be activated and connected (status window shows “CONNECTED") but

without the code (status window shows “NO CODE”), transfer the code pressing F5, through the icon
or from the menu “Online” > “Online download code”.
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Verify that the status bar visualize”CONNECTED” and “SOURCE OK”. If “NO CODE is still visualized, restart
the simulator pressing # or from the menu “On-line” > “Target reboot”.
On Movicon, entering the Pixsys driver configurator and configure as follows:

1.

. Enter the folder where the simulator is

. Select the localhost address: 127.0.0.1
. From the section “General” assign a

Enter the folder where the LogicLab
project resides and select the file
NameMyProjectLogicLab.sym.xml

operating, set as filter “All files (**) and
select the file NameMyProjectLogicLab.
sym.simul. Pay attention to the file
exstension, into the project folder there
are many files with the same name but
different extension.

name to the station, ex. “PLC".

At this point, to start the simulation of the graphic interface connected to the simulator (which is
already executing the code previously downloaded), press Alt+F12, theicon  or from the menu “File”

> “Start Project”.

To end the simulation, press Alt+F12 or theicon  on the bar which appears on the upper side.
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Warranty terms

Pixsys srl warrants its electronic devices for 12 months from Invoice date. Pixsys liability shall be limited
to repairing (or replacing at its option) any defective product which is returned with RMA (Return
Material Authorization) priorly obtained on Pixsys website and to be clearly marked on documents.
Pixsys shall not be responsible for accident, neglect, misuse, damage to objects or people caused
using the devices outside their specifications or outside any published performance data, including
unauthorized and unqualified repairing or failure to provide proper environmental conditions. In no
event shall Pixsys liability exceed the purchase price of the product(s).

Warranty does not cover any damage arising from post-sale installation of software applications and
specifically any damage caused by malware. Technical assistance by Pixsys which should be required
to restore OS will be subject to assistance fee prevailing at time of request.

Notes / Updates
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1 Norme di sicurezza

Le indicazioni di questo manuale sono riferite a prodotti Pixsys quali i dispositivi logici programmabili
(PLC) e i dispositivi di controllo e monitoraggio (PC industriali, HMI) da ora in poi identificati
semplicemente con il termine “Il dispositivo” o “i dispositivi”. | dispositivi realizzati e commercializzati
da Pixsys sono progettati, sviluppati e realizzati per un uso convenzionale in ambienti industriali. Non
sono stati progettati, sviluppati e realizzati per qualsiasi altro uso che possa comportare gravi rischi
o pericoli quali decesso, lesioni, gravi danni fisici senza che siano adottati rigorosi sistemi di sicurezza
indipendenti dal dispositivo. In particolare, tali rischi e pericoli includono I'uso di questi dispositivi per
monitorare le reazioni nucleari nelle centrali, il loro uso nei sistemi di controllo o sicurezza del volo,
nonché nel controllo di sistemi di trasporto di massa, supporto a sistemi salvavita medicali o sistemi
d'armamento.

1.1 Regolamenti e procedure

| dispositivi elettronici non sono mai completamente sicuri. Se il dispositivo viene meno al suo
funzionamento, l'utente é responsabile di garantire che altri dispositivi connessi, ad es. motori,
siano portati in una condizione di sicurezza. Le precauzioni di sicurezza inerenti i sistemi di controllo
industriale devono essere adottate in conformita alle normative nazionali e internazionali applicabili
quando si utilizzano i dispositivi come sistemi di controllo insieme a Soft-PLC. Lo stesso vale per tutti
gli altri dispositivi collegati al sistema. Tutte le operazioni come l'installazione, la messa in servizio e la
manutenzione dei dispositivi devono essere eseguite solo da personale qualificato.

Il personale qualificato deve avere familiarita con il trasporto, montaggio, installazione, messa in
servizio e funzionamento dei dispositivi ed avere le previste qualifiche ad operare (ad esempio IEC
60364). E necessario osservare le norme nazionali sulla prevenzione degli incidenti.

Le avvertenze di sicurezza, le informazioni sulle condizioni di collegamento (etichette e documenta-
zione) e i valori limite specificati nei dati tecnici devono essere letti attentamente prima dell’installa-
zione e della messa in servizio e devono essere sempre osservati.

1.2 Linee guida per l'installazione

+ Questi dispositivi non sono pronti per I'uso al momento della consegna, devono essere installati
e cablati secondo le indicazioni specifiche di questa documentazione al fine di rispettarne i limiti
EMC e gli standard di sicurezza.

» Linstallazione deve essere eseguita secondo questa documentazione utilizzando attrezzature e
strumenti adeguati.

« | dispositivi devono essere installati solo da personale qualificato senza tensione applicata. Prima
dell'installazione, la tensione all'armadio elettrico deve essere spenta e ne deve essere impedita
I'accensione per tutto il tempo dell'intervento.

« Devono essere osservate le linee guida generali sulla sicurezza e le norme nazionali sulla
prevenzione degli incidenti.

- Linstallazione elettrica deve essere eseguita in conformita alle linee guida applicabili (ad esempio
sezioni trasversali della linea, fusibili, collegamenti di terra protettivi).

1.3 Virus e programmi pericolosi

Questo sistema & soggetto a potenziali rischi ogni volta che i dati vengono scambiati o il software
viene installato da un supporto dati (ad esempio CD-ROM o flash-disk USB), una connessione di
rete o Internet. Lutente e responsabile della valutazione di questi pericoli, implementando misure
preventive come programmi di protezione antivirus, firewall, ecc. e assicurandosi che il software sia
ottenuto solo da fonti attendibili.
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1.4 Organizzazione delle note di sicurezza
Le note sulla sicurezza in questo manuale sono organizzate come segue:

Note di sicurezza |Descrizione

Danger! La mancata osservanza di queste linee guida e avvisi di sicurezza puo essere
potenzialmente mortale.

La .ma.ncata.osserva.nza di qqe§te linee gL{idz? e avvisi di sicurezza pud comportare
lesioni gravi o danni sostanziali alla proprieta.

La mancata osservanza di queste linee guida e avvisi di sicurezza puo provocare

lesioni o danni alle cose.
IIVEIINEENY | Tali informazioni sono importanti per prevenire errori.

2 TdControlPanel

All'avvio del dispositivo si apre un progetto che consente
di verificare lo stato generale della macchina, data e ora di
sistema, indirizzo IP associato, esecuzione del SoftPLC in
background.

Utilizzando un client VNC é possibile visualizzare dal proprio PC quello che viene visualizzato a video
sul PLC/HMI. Avviando un browser con servizio Java attivo & inoltre possibile testare se la funzione di
Webserver del dispositivo € attiva. Per questa funzione & necessario I'uso del browser Internet Explorer.

Dal pulsante “Td Control Panel,” si accede al pannello

di controllo del dispositivo, dove € possibile verificare e
configurare i vari servizi e progetti da lanciare all'avvio,
oltre a poter configurare il tempo di attesa per lo
spegnimento della retroilluminazione, il buzzer al tocco del
display ecc.

Nei paragrafi seguenti verra descritta ciascuna funzione delle finestre presenti nel TdControlPanel.
NB: Le foto mostrano la configurazione di default del dispositivo.

2.a WIN EXPLORER

Da questa finestra e possibile scegliere un set di opzioni

delle modalita di avvio di Windows CE ed esecuzione di

TDControlPanel.

« La prima opzione avvia Windows CE con desktop.

« Laseconda opzione permette I'avvio del TDControl-
Panel se, durante l'avvio del terminale, si mantiene
premuto il pulsante “Stop” @.

- Abilitando la terza opzione sara possibile impostare
una password di protezione per evitare che utenti non
autorizzati, tenendo premuto il pulsante di “STOP” @,
accedano alle impostazioni del TDControlPanel.

Il pulsante “START WINDOWS DESKTOP” permette di avviare il servizio “Explorer.exe” e quindi di
accedere al desktop di Windows CE.
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2b

HMI_MOVICON

Da questa finestra & possibile selezionare quali servizi e
programmi relativi a Movicon 11 eseguire in automatico
all'avvio del dispositivo.

Le funzionalita dello scada Movicon sono disponibili in
tutti gli HMI e nel PL500 nella versione “WEB” (PL500-
335-1AD-WEB)

Il pulsante “START” avvia il progetto Movicon (ed il servizio di upload file) manualmente.

2.c

PLC LOGICLAB

Da questa finestra si abilita/disabilita I'esecuzione del
SoftPLC all'avvio del dispositivo. Selezionando il flag “RUN
console DEBUG”, durante I'esecuzione del SoftPLC, la finestra
di Debug sara compilata con gli eventi di sistema in tempo
reale per poter verificare eventuali anomalie.

NB: questa funzione richiede molte risorse al dispositivo.

Si consiglia di mantenerla attiva solo se si riscontrano
problemi durante lo sviluppo del software. E bene
disabilitarla al termine della fase di sviluppo!

Il pulsante “START” avvia il progetto SoftPLC (e I'eventuale finestra di debug) manualmente.

2d

2.e

LAN ETH1

BACKLIGHT - BUZZER

Da questa finestra e possibile modificare i parametri della
configurazione di rete del dispositivo. Eventuali modifiche
richiedono un riavvio per essere applicate.

NB: affinché si possa trasferire il programma SoftPLC e
Movicon sul dispositivo, questo deve avere un indirizzo
fisso, non é possibile lavorare in DHCP.

L'indirizzo IP di default degli HMI & 192.168.0.100
Lindirizzo IP di default del PL500 & 192.168.0.99

Da questa finestra e possibile configurare i parametri
relativi la retroilluminazione e il buzzer. Abilitando la
funzione “Always ON” la retroilluminazione resta sempre
attiva, nel caso contrario nel terzo campo “Backlight ON
for..(sec)” si dovra inserire il tempo in secondi per avviare
lo spegnimento o l'attenuazione della lampada. Nel 1° e 2°
campo si possono impostare: la percentuale di accensione
della lampada (100% = accesa, 0%=spento) nello stato di
lavoro normale o nello stato di standby. Il quarto campo
“Buzzer frequency” permette di impostare la frequenza del
suono del buzzer piu la frequenza ¢ alta pit il suono sara
acuto. ll flag “Buzzer OFF” disabilita il buzzer al tocco del
touch. | pulsanti “TEST” permettono di testare i parametri
impostati prima di salvare la configurazione.
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2.f

2.9

WINVNC
Da questa finestra si abilita/disabilita il servizio di
Desktop remoto di VNC. Il pulsante “START VNC”
abilita manualmente tale servizio. Il pulsante “START
VNC_CONFIG" apre la finestra di configurazione di
VNC per poter impostare il sistema di autenticazione,
cambiare la password di accesso ecc. Attenzione la
modifica dei parametri & consigliata per utenti avanzati, la
manomissione dei parametri in modo errato provochera
il malfunzionamento del servizio di desktop remoto. La
password di default per I'accesso al Desktop remoto del
dispositivo via VNC & “1234",

BACKUP-RESTORE

BACKUP: procedura per eseguire il backup (caricamento da HMI) dei progetti LogicLab e Movicon.

Una volta scaricati i progetti LogicLab e Movicon sul
dispositivo e configurato quest’ultimo in modo da eseguirli
ad ogni accensione, spegnere e riaccendere il dispositivo
tenendo premuto il simbolo di “STOP”

In questo modo si avvia la finestra del TDControlPanel

A questo punto inserire una penna USB, formattata in
FAT32, su una delle porte USB disponibili.

Premere “BACKUP-RESTORE" per accedere all'utility che
permette il backup dei progetti e della configurazione del
dispositivo.

Da questa finestra si puo scegliere di quali risorse effettuare il backup:

20-

PLC_LOGICLAB (RUNTIME-PROJECT): esegue il backup del progetto LogicLab (e dell'intero
Runtime), oltre che della configurazione effettuata nella finestra “PLC_LOGICLAB" (accessibile dalla
finestra principale del TDControlPanel).

HMI_MOVICON(PROJECT): esegue il backup del solo progetto Movicon, oltre che della configura-
zione effettuata nella finestra “HMI_MOVICON" (accessibile dalla finestra principale del TDControl-
Panel).

HMI_MOVICON (RUNTIME): esegue il backup del solo Runtime

TdControlPanel (Configuration): esegue il backup dell'intera configurazione effettuata nelle varie
utility accessibili dalla finestra principale del TdControlPanel. NB: In questo modo si effettua il
backup anche dell'eventuale password di accesso al TdControlPanel, se impostata dalla finestra
“WIN EXPLORER".

LAN (IP CONFIGURATION): esegue il backup della configurazione di rete del dispositivo.

BOOT SCREEN: esegue il backup dell'immagine di sfondo che si visualizza durante l'avvio del
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sistema.
Abilitando tutte le spunte, si ottiene un backup completo della configurazione e dei software presenti
nel dispositivo, utile per velocizzare la programmazione in serie di pi pannelli operatore.

Premendo il tasto “BACKUP TO USB DISK” verra aperta

la memoria USB collegata al terminale e sara possibile
selezionare una cartella di destinazione ed il nome del file
di backup (il nome predefinito del file sara la data e I'ora di
creazione di questo).

Premendo “OK” la procedura di backup inizia (si vedra una
clessidra al centro dello schermo).

Un popup di conferma indica il termine della procedura.
Premendo “OK” si chiude il popup ed é quindi possibile
premere “ESC” e poi spegnere il dispositivo.

RESTORE: procedura per eseguire il ripristino (caricamento su HMI) dei progetti LogicLab e Movicon.

Per effettuare la programmazione di un nuovo dispositivo
a partire da un backup, tenere premuto il simbolo di “STOP”
in fase di accensione.

In questo modo si avvia la finestra del TDControlPanel

A questo punto inserire la penna USB contenente il Backup
su una delle porte USB disponibili.

Premere “BACKUP-RESTORE" per accedere all'utility che
permette il ripristino dei progetti e della configurazione
del dispositivo.
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Premendo il tasto “RESTORE FROM USB DISK” verra aperta
la memoria USB collegata al terminale e sara possibile
selezionare il file di backup creato precedentemente.

Premendo “OK” la procedura di restore inizia (si vedra una
clessidra al centro dello schermo).

Un popup di conferma indica il termine della procedura.
Premendo “OK” si chiude il popup ed é quindi possibile
premere “ESC” e poi spegnere il dispositivo.

Da questo momento, ad ogni accensione il dispositivo avviera i progetti (e I'intera configurazione se
selezionata durante la fase di backup) automaticamente.

3 Suite LogicLab (solo HMI+SoftPLC)

La Suite LogicLab e I'ambiente di sviluppo di Pixsys per la programmazione del PLC PL500 e di tutta la
famiglia di terminali operatore e PanelPC.

La suite & scaricabile dall'area download del sito pixsys.net, previa registrazione e non necessita di
codici di attivazione. E compatibile con tutte le versioni di Windows 32/64bit a partire da Windows
XP SP3 ed é disponibile in lingua inglese e in italiano. Una volta scaricato il file di setup sul proprio
computer, avviare l'installazione e seguire la procedura standard. Una volta installato il programma,
si avvia tramite I'icona "LogicLab” @ sul desktop oppure dal menu “Start” > “PixsysSuite” > “LogicLab”.

3.a Cambio lingua

Per cambiare la lingua di visualizzazione &
necessario aprire la finestra delle opzioni dal
menu “File” > “Options”, passare alla scheda
“Language”, selezionare la voce “ITA - italiano”
e premere “Select”. Confermare quindi con “OK”
ed infine chiudere e riaprire LogicLab affinché
le modifiche abbiano effetto.

3.b Creazione - caricamento di un progetto

Apertura di un progetto esistente:

« Con LogicLab aperto, fare click sul pulsante
“Apri progetto” oppure selezionare uno degli
ultimi progetti aperti dall’elenco proposto.

» Con Logiclab chiuso, entrare nella cartella del
progetto e fare doppio click sul file con il nome
del progetto desiderato che avra I'icona @ ed
estensione “.plcprj"”.
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Creare un nuovo progetto:

Premere il pulsante “Nuovo Progetto”.

Nella finestra che appare, digitare un nome per il
progetto ed identificare la cartella dove verranno
inseriti i file del progetto. Selezionare infine il
dispositivo che si vuole programmare.

Attenzione: selezionando il flag “rispetta maiuscole/minuscole”, una variabile che contiene una lettera
maiuscola sara intesa come diversa da un‘altra di uguale nome ma con tale lettera minuscola.
Consigliamo quindi di lasciare disabilitata tale selezione, per evitare confusione durante la stesura del
codice programma.

3.c

Collegamento al target

Si elencano di seguito i requisiti necessari per il corretto collegamento tra target (dispositivo da
programmare) e I'ambiente di sviluppo su PC (LogicLab).
Requisiti da verificare sul target:

dispositivo acceso e avviato

configurato con indirizzo IP statico compatibile con la rete dove si trova ed il PC con cui si
dovra connettere. Di default, I'indirizzo IP dei terminali HMI & 192.168.0.100, quello del PL500 e
192.168.0.99, quindi il PC dove si sta sviluppando dovra avere la stessa rete e classe (in questo caso
192.168.0.XXX) ma indirizzo fisico diverso (cioé le ultime 3 cifre dell'indirizzo IP, con un qualsiasi
numero compreso tra 1 e 255, diverso da 100). Se & necessario cambiare l'indirizzo IP del terminale
rispetto a quello di default, fare riferimento alla configurazione del TD Control Panel, sezione “LAN
ETH1" al par. 2.d.

connessione con cavo di rete (diretto o cross) direttamente al PC o attraverso uno switch di rete
SoftPLCin esecuzione (per questo fare riferimento alla configurazione del TD Control Panel, sezione
“PLC LOGICLAB" al par. 2.c).

Requisiti da verificare sul PC di sviluppo:

indirizzo IP compatibile con la rete esistente dove si trova e con l'indirizzo IP configurato nel target
(vedi punti precedenti)

antivirus/firewall che permetta la connessione a dispositivi nella rete (di norma sono gia configurati
correttamente)

LogicLab configurato per connettersi al target collegato che si vuole programmare: per fare cio,
navigare sul menu “On Line” > “Imposta comunicazione” e nella finestra che appare, premere il
pulsante “Properties” e poi alla voce “IP Address” inserire I'indirizzo IP del target, lasciando inalterato
tutto il resto. Nel caso di reti molto lente o di una configurazione di rete con diversi switch, &
possibile aumentare il valore “Timeout” (espresso in mS).

Limmagine rappresenta la configurazione di default

Confermare tutte le finestre premendo su “OK” e salvare attraverso I'icona o attraverso il menu “file”
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> “Salva Progetto”.

A questo punto, per verificare che la configurazione del LogicLab e del target sia corretta, si puo
effettuare la connessione premendo licona ¥ oppure dal menu “On Line” > “Connetti”. Se la
connessione va a buon fine la barra di stato in basso a destra visualizzera “CONNESSO” e “NO CODICE”
ad indicare che il target € connesso e non ha codice al suo interno oppure “CODICE DIFF” ad indicare

che il codice che si sta visualizzando non corrisponde a quello che risiede nel target.

3d Compilazione e scaricamento del codice

Una volta inserito il codice progetto € necessario compilarlo per verificare che non ci siano errori,
premendo il tasto F7, attraverso l'icona & oppure dal menu “Progetto” > “Compila”.

Se la compilazione va a buon fine si puo trasferire il programma al target premendo il tasto F5,
attraverso I'icona  oppure dal menu “On Line” > “Trasferimento codice”.

A questo punto la barra di stato visualizzera “CONNESSO” e “SORGENTE OK” indicando che il programma
in esecuzione nel target corrisponde a quello che si sta visualizzando sul PC.

3.e La watch window

Se il programma in esecuzione nel target corrisponde a quello che si sta visualizzando sul PC, la barra
di stato visualizza “CONNESSO” e “SORGENTE OK” ed & quindi possibile utilizzare la finestra di “Watch”
per verificare, in tempo reale, lo stato delle variabili utilizzate nel progetto. Per abilitare la finestra
di “Watch”, premere i tasti CTRL+T oppure usare il menu “Vista” > “Finestra strumenti” > “Watch”. Per
aggiungere una variabile alla finestra di “Watch” é sufficiente trascinarla al suo interno oppure premere
licona e selezionarla manualmente.

Da questo momento, la finestra di “Watch”
comincera a visualizzare il valore della variabile
inserita, in tempo reale.

Attraverso gli appositi pulsanti e possibile inoltre salvare, caricare e aggiungere all’elenco
delle variabili, una watch-list gia esistente.

Se si desidera cambiare il formato di visualizzazione, &
sufficiente selezionare la variabile e premere I'icona
. Dalla finestra che appare selezionare quindi il formato
desiderato e confermare con “OK”.

4 Interfacciare Movicon 11 e LogicLab (solo HMI+SoftPLC)

NB: ¢ richiesto Movicon 11.5 o successivi.

Da effettuare solo la prima volta:

Nel PC dove si sta sviluppando, scaricare dall'area dowload del sito Pixsys, nella sezione Movicon,
il “MOVICON 11.6 Update-Aggiorna Driver.exe” corrispondente all'architettura del pc in uso. Doppio
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click per avviarlo e seguire le istruzioni a video.

Nel caso si utilizzi un Panel PC (TD750-TD850-TD900-TD910-TD920) va fatto anche sul Panel PC.
Premessa: con questa procedura vengono importate tutte le variabili di sistema del PLC e tutte le
variabili create ed usate nel progetto PLC.

La creazione e I'aggiornamento dell’elenco delle variabili PLC avviene solamente se il programma
LogicLab & compilato senza errori e scaricato sul target.

4.a Creazione di un nuovo progetto Movicon

Avviare il software e scegliere la piattaforma “Windows®X86 / X64" per i Panel-PC e “Windows® CE” per gli
HMI e per il PL500 versione “WEB”. Se si sta creando un nuovo progetto Movicon seguendo il Wizard,
al termine verra visualizzata la finestra di configurazione del driver, passare quindi direttamente alla
sezione “Configurazione del Driver” al par. 4.b. Se invece si sta installando il driver manualmente, seguire
i passi successivi.

Aggiungere il driver di comunicazione facendo
click con tasto destro su “Real time DB” quindi
“nuovo driver di comunicazione”.

Selezionare dal menu dei produttori “Pixsys” e
poi “Pixsys SoftPLC Driver”.

Confermare con “OK” e fare doppio click sul
driver appena creato per aprire la finestra di
configurazione.

4.b Configurazione del Driver

Selezionare la scheda “Station” e aggiungere
una nuova stazione con il pulsante “ADD".
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. Inserire il percorso del sorgente del

progetto LogicLab situato nel PC su cui
si sta sviluppando. Questo permette di
importare le variabili ed eseguire in modalita
preview Movicon sul proprio PC di sviluppo,
compresa laverifica dellacomunicazione con
il SoftPLC. Per questa funzione, & necessario
che nel passo successivo si indichi lI'indirizzo
IP del terminale che si sta programmando
(solo al termine dello sviluppo si dovra
inserire |'indirizzo localhost 127.0.0.1 per far
si che il progetto Movicon comunichi con il
SoftPLC risiedente nella stessa macchina).

2. Questo campo si autocompila dopo aver inserito il percorso del punto 1: nel caso di utilizzo degli
HMI e del PL500, non modificare il campo auto-compilato. Nel caso di Panel-PC (TD750-TD850-
TD900 ecc.) inserire il percorso dove e stato effettuato il download del progetto LogicLab (di
default “D:\LLExec\NomeMioProgettoLogicLab.sym.xml").

3. Se l'applicativo Movicon sara eseguito nel Panel HMi o nel Panel-PC dove & presente anche il

SoftPLC, inserire I'lP address 127.0.0.1.

Se invece Movicon sara eseguito in un Panel HMi o Panel-PC diverso da dove risiede il SoftPLC, si

dovra inserire I'indirizzo IP del softPLC.

4. Dalla sezione “General” assegnare un nome alla stazione, ad esempio: “PLC".

Premere OK per salvare le impostazioni e uscire.

Ora e possibile importare le variabili del
progetto LogicLab in Movicon.

Premere il tasto destro su “Pixsys SoftPLC”" e
selezionare “Importa database PLC".

Premere il tasto “Read from PLC project”, verra
fornito I'elenco delle variabili disponibili.

Selezionare quindi le variabili che si vogliono
importare e premere il tasto “Import”.

NB: Nel caso di importazione di una variabile di tipo array, questa sara visualizzata come una struttura
che porta il nome del array. | singoli membri dell’array saranno accessibili singolarmente con la sintassi
NomeMioArray:NomeMioArray _X dove X € I'indice dell’array (a partire da 0).

Ora le variabili sono disponibili nel progetto di Movicon. Qualora ci fosse la necessita di importare
nuove variabili, ad esempio nel caso di modifica del progetto di LogicLab, ripetere solo la procedura

di lettura ed importazione delle variabili.
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4.c Trasferimento del codice Movicon nel target
Per trasferire il progetto Movicon, usare I'icona:

1. Selezionare il protocollo per il trasferimento: TCP

2. Inserire I'indirizzo IP del target (default per HMI/
PLC: 192.168.0.100)

3. Nel caso di HMI/PLC lasciare vuoto, nel caso di
Panel-PC inserire user (o il nome dell’'utente con
cui si e effettuato I'accesso nel Panel-PC target).

4. Nel caso di HMI/PLC lasciare vuoto, nel caso di
Panel-PCinserire 123456

5. Nel caso di HMI/PLC inserire \NandFlash\No-
meMioProgettoMovicon\, nel caso di Panel-PC
inserire D:\NomeMioProgettoMovicon\.

In questo modo Movicon creera una cartella
chiamata NomeMioProgettoMovicon e scarichera
tutti i file del progetto dentro ad essa.

6. Premete il tasto “Trasferisci Progetto (Upload)" per
avviare il trasferimento (premere “Yes to All" nel
caso sia gia stato scaricato un progetto prece-
dentemente e si voglia sovrascriverlo).

7. Una volta terminato la procedura di download,
premere “Avvia Progetto sul Dispositivo” per farlo
eseguire sul target (il progetto in esecuzione
sara terminato e si avviera l'ultimo trasferito).

NB: Nel caso si voglia trasferire pil progetti/versioni differenti, & sufficiente cambiare la cartella di
destinazione (va mantenuto comunque la prima parte \NandFlash\). Dal TdControlPanel si dovra
scegliere quale progetto tra i presenti nella memoria del dispositvo si dovra avviare in automatico
all'accensione del target (vedi paragrafo 10.b).

5 Simulazione dell’'intero progetto SoftPLC + SCADA
(solo HMI+SoftPLC)

Da LogicLab, lanciare il simulatore dallicona = oppure dal menu “Debug” > “Modo simulazione”. Nella
finestra che appare, creare una nuova area di lavoro indicandone il nome e la cartella di destinazione
(di default é selezionata la cartella dove risiede il progetto).

A questo punto, il simulatore risultera avviato e connesso (la finestra di stato segnalera lo stato
“CONNESSO”) ma senza codice (la finestra di stato segnalera lo stato “NO CODICE”), trasferire quindi il
codice premendo il tasto F5, attraverso I'icona  oppure dal menu “Online” > “Trasferimento codice”.
Verificare che la barra di stato visualizzi “CONNESSO” e “SORGENTE OK”. In caso si visualizzi ancora “NO
CODICE"), riavviare il simulatore premendo l'icona % oppure dal menu “On-line” > “Target reboot”.

Da Movicon, entrare nella finestra di configurazione del driver Pixsys e configurare come segue:
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1. Entrare nella cartella dove risiede il
progetto LogicLab e selezionare il file
NomeMioProgettoLogicLab.sym.xml

2. Entrare nella cartella dove il simulatore
sta lavorando, impostare come filtro per
il tipo di file “All files (**) e selezionare il
file NomeMioProgettoLogicLab.sym.simul.
Fare molta attenzione all'estensione del
file, in quanto nella cartella di progetto
esistono molti file con lo stesso nome ma
con estensione differente.

3. Impostare l'indirizzo localhost: 127.0.0.1

4. Dalla sezione “General” assegnare un
nome alla stazione, ad esempio: “PLC".

A questo punto, per lanciare la simulazione dell'interfaccia grafica collegata al simulatore (che sta

gia eseguendo il codice precedentemente scaricato) € sufficiente premere i tasti Alt+F12, I'icona

oppure dal menu “File” > “Avvia Progetto”.

Per terminale la simulazione, premere i tasti Alt+F12 oppure I'icona  nella barra che appare in alto.
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Responsabilita limitata

Pixsys S.r.l. garantisce le proprie apparecchiature elettroniche per un periodo di 12 mesi a decorrere
dalla data di fatturazione. La garanzia del Costruttore & limitata alla riparazione o sostituzione delle
parti che presentino difetti di fabbricazione e che siano rese franco nostra sede citando il numero di
autorizzazione al reso (procedura interna autorizzazione RMA). Pixsys declina ogni responsabilita per
incidenti e danni a persone o cose derivanti da manomissione (inclusi tentativi di riparazione da parte
di personale non autorizzato), condizioni ambientali non idonee, installazione scorretta, uso errato,
improprio e comunque non conforme alle caratteristiche dello strumento dichiarate nella documen-
tazione tecnica. In nessun caso la responsabilita del costruttore eccede il valore della strumentazione.
La garanzia non copre in alcun modo i problemi derivanti dall’installazione di applicativi software
successiva alla vendita, ed in particolare i danni conseguenti all'esecuzione di malware. Eventuali
interventi di assistenza da parte di Pixsys per il ripristino di sistema operativo o programmi saranno
soggetti alla tariffa di assistenza vigente.

Note / Aggiornamenti
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1 Sicherheitsvorschriften

Diese Bedienungsanleitung bezieht sich auf Pixsys-Produkte wie speicherprogrammierbare
Steuerungen (SPS) sowie Steuerungs- und Uberwachungsgerite (Industrierechner, HMIs). Sie werden
in der Folge einfach als ,Gerdt” oder ,Gerdte” bezeichnet. Die von Pixsys entwickelten und vertriebenen
Gerate werden fiir den konventionellen Einsatz in Industrieumgebungen entworfen, entwickelt und
hergestellt. Sie sind nicht fiir andere Verwendungszwecke ausgelegt. Jede andere Verwendung kann
bei fehlendem Einsatz von gerdteunabhdngigen, eigenstdndigen Sicherheitssystemen ernsthafte
Risiken oder Gefahren wie Tod, Verletzungen oder schwere kérperliche Schaden mit sich bringen.
Diese Risiken und Gefahren umfassen insbesondere die Verwendung dieser Gerite zur Uberwachung
von Kernreaktionen in Kraftwerken, in Flugkontroll- oder Flugsicherheitssystemen, zur Steuerung
von Massentransportsystemen und zur Unterstiitzung lebensrettender medizinischer Systeme oder
Waffensysteme.

1.1 Vorschriften und Verfahren

Elektronische Gerate bieten nie vollige Sicherheit. Ist das Gerat gestort oder nicht mehr funktionstiich-
tig, hat der Anwender dafiir zu sorgen, dass andere angeschlossene Geréte, beispielsweise Motoren,
gesichert werden. Bei Verwendung der Geréte als Steuerungssysteme in Verbindung mit SoftPLC sind
die Sicherheitsvorkehrungen fiir industrielle Steuerungen in Ubereinstimmung mit den geltenden
nationalen und internationalen Vorschriften zu treffen. Gleiches gilt fir alle anderen an das System
angeschlossenen Geréte. Alle Arbeiten wie die Installation, Inbetriebnahme und Instandhaltung der
Gerate missen von qualifiziertem Fachpersonal durchgefiihrt werden.

Das qualifizierte Fachpersonal muss mit dem Transport, der Montage, der Installation, der Inbetrieb-
nahme und dem Betrieb der Gerédte vertraut sein und die fiir den Betrieb erforderlichen Qualifikationen
(z.B. IEC 60364) besitzen. Dabei missen die nationalen Unfallverhiitungsvorschriften zur Anwendung
kommen.

Die in den technischen Daten enthaltenen Sicherheitshinweise, Verdrahtungsbedingungen
(Typenschilder und Anleitungen) und Grenzwerte sind vor der Installation und Inbetriebnahme
sorgféltig zu lesen und immer zu beachten.

1.2 Installationsrichtlinien

+ Diese Geréte sind zum Zeitpunkt der Lieferung nicht betriebsbereit. Sie miissen unter Beachtung
der vorliegenden Bedienungsanleitung installiert und verdrahtet werden, damit die EMV-Grenz-
werte und Sicherheitsvorschriften eingehalten werden kdnnen.

«+ Die Installation muss gemdaR der vorliegenden Bedienungsanleitung mit geeigneten Geréaten und
Werkzeugen durchgefiihrt werden.

- Die Gerate diirfen nur von Fachpersonal und im spannungsfreien Zustand installiert werden. Vor
der Installation muss die an den Schaltschrank angelegte Spannung unterbrochen werden und fiir
die gesamte Dauer der Arbeiten unterbrochen bleiben.

+ Die allgemeinen Sicherheitsrichtlinien und die nationalen Unfallverhiitungsvorschriften sind
immer zu beachten.

- Die elektrische Installation muss gemaR den geltenden Richtlinien (z.B. Leitungsquerschnitte,
Sicherungen, Schutzerdungen) durchgefiihrt werden.

1.3 Viren und gefahrliche Programme

Bei jedem Datenaustausch oder bei der Installation der Software ausgehend von einem Datentrager
(CD-Rom oder USB-Flashspeicher) oder bei einer Netzwerkanbindung oder Internetverbindung ist
dieses System potentiellen Risiken ausgesetzt. Zur Vermeidung solcher Gefahren obliegt es dem
Anwender, Schutzmaf3nahmen wie die Installation von Virenschutzprogrammen, Firewalls usw. zu
ergreifen und sicherzustellen, dass die Software nur aus zuverlassigen Quellen bezogen wird.
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14 Bedeutung der Sicherheitshinweise
Die Sicherheitshinweise in diesem Handbuch sind wie folgt zu verstehen:

Sicherheitshinweise |Beschreibung

Die Nichtbeachtung dieser Richtlinien und Sicherheitshinweise kann lebens-
1

gefahrlich sein.

Die Nichtbeachtung dieser Richtlinien und Sicherheitshinweise kann zu schweren
al

Verletzungen oder erheblichen Sachschaden fiihren.

Vorsicht! Die Nichtbeachtung dieser Sicherheitsrichtlinien und Warnungen kann zu
Verletzungen oder Sachschéden fiihren.

Hinweis!| Diese Informationen sind wichtig, um Fehlern vorzubeugen.

2 TdControlPanel

Beim Hochfahren des Gerats wird ein Projekt gedffnet,
welches den allgemeinen Geratestatus, das Systemdatum,
die Systemzeit, die zugehorige IP-Adresse und die
Ausfiihrung von SoftPLC im Hintergrund Gberpriifen lasst.

Mit einem VNC-Client kann vom eigenen Rechner aus der Bildschirminhalt der SPS/HMI visualisiert
werden. Durch Starten eines Browsers mit aktivem Java-Dienst kann auch getestet werden, ob
die Webserver-Funktion des Gerdts aktiv ist. Flir diese Funktion ist der Internet-Explorer-Browser
erforderlich.

Uber die Schaltfliche ,Td Control Panel” wird das
Bedienterminal des Gerats aufgerufen. Dort kdnnen die
verschiedenen Dienste und Projekte, die beim Einschalten
gestartet werden sollen, Gberprift und konfiguriert
werden, ebenso wie die Wartezeit bis zum Ausschalten der
Hintergrundbeleuchtung, der Summer bei Berlihrung des
Displays usw.

In den folgenden Abschnitten werden die einzelnen Funktionen im TdControlPanel beschrieben.
Anmerkung: Die Fotos beziehen sich auf die Standardkonfiguration des Geréts.

2.a WIN EXPLORER

In diesem Fenster kdnnen die Startoptionen von Windows

CE und die Ausfiihrungsoptionen von TDControlPanel

gewahlt werden.

« Die erste Option startet Windows CE mit dem Desktop.

« Die zweite Option startet TDControlPanel, wenn
beim Starten des Bedienterminals die Stopp-Taste &
gedriickt wird.

« Die dritte Option lasst einen Passwortschutz einrichten,
damit unbefugte Benutzer nicht auf die Einstellungen
des TDControlPanel zugreifen kdnnen. Hierzu wird
die Stopp-Taste € gedriickt gehalten, um zu den
Einstellungen des TDControlPanel zu gelangen.

Mit der Schaltflache ,START WINDOWS DESKTOP* wird der Dienst ,Explorer.exe” gestartet und erfolgt
der Zugriff auf den Desktop von Windows CE.
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2.b HMI_MOVICON

2.c PLCLOGICLAB

In diesem Fenster kann gewdhlt werden, welche Dienste
und Programme in Bezug auf Movicon 11 beim Start des
Gerats automatisch ausgefiihrt werden sollen.

Die Movicon-SCADA-Funktionen sind in allen HMIs und
im PL500 in der ,WEB“-Version (PL500- 335-1AD-WEB)
verfiigbar.

Die Schaltflache ,START" lasst das Movicon-Projekt (und
den Datei-Upload-Dienst) manuell starten.

Dieses Fenster aktiviert/deaktiviert die Ausfiihrung von
SoftPLC beim Gerétstart. Durch die Wahl des Flags ,RUN
console DEBUG" wird das Debug-Fenster wahrend der
Ausfiihrung von SoftPLC mit Echtzeit-Systemereignissen
gefillt, um auf Anomalien zu priifen.

Anmerkung: Diese Funktion ist sehr ressourcenaufwandig.
Es empfiehlt sich, sie nur aktiv zu halten, wenn bei der
Softwareentwicklung Probleme auftreten. Sie sollte nach
Beendung der Entwicklungsphase deaktiviert werden!

Die Schaltflache ,START" lasst das SoftPLC-Projekt (und ggf. das Debug-Fenster) manuell starten.

2d LAN ETH1

2le BACKLIGHT - BUZZER
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In diesem Fenster konnen die Parameter der‘[\letzwerkkon-
figuration des Gerdts geandert werden. Alle Anderungen
erfordern einen Neustart, um tGbernommen zu werden.

Anmerkung: Um das SoftPLC-Programm und Movicon
auf das Gerat libertragen zu kdnnen, muss das Gerat
eine feste Adresse haben; mit DHCP kann nicht
gearbeitet werden.

Die Standard-IP-Adresse der HMIs ist 192.168.0.100. Die
Standard-IP-Adresse des PL500 ist 192.168.0.99.

In diesem Fenster kdnnen die Parameter fiir die Hinter-
grundbeleuchtung und den Summer konfiguriert werden.
Bei Aktivierung der Funktion ,Always ON” bleibt die
Hintergrundbeleuchtung immer eingeschaltet; andernfalls
muss im dritten Feld ,Backlight ON for..(sec)” die Zeit in
Sekunden eingegeben werden, nach welcher die Lampe
ausgeschaltet oder gedimmt werden soll. Im 1. und 2. Feld
kann der Prozentsatz der Beleuchtung (100% = eingeschal-
tet, 0% = ausgeschaltet) im normalen Betriebszustand oder
im Standby-Zustand eingestellt werden. Im vierten Feld
,Buzzer frequency” kann die Frequenz des Summertons
eingestellt werden: Je hoher die Frequenz, desto lauter

ist der Ton. Das Flag ,Buzzer OFF” schaltet den Summer

bei Beriihrung aus. Mit den Schaltflachen ,TEST” kénnen
die eingestellten Parameter getestet werden, bevor die
Konfiguration gespeichert wird.



2.f

2.9

WINVNC
Dieses Fenster aktiviert/deaktiviert den VNC-Remote-Desk-
top-Dienst. Die Schaltflache ,START VNC" aktiviert diesen
Dienst manuell. Die Schaltflache ,START VNC_CONFIG"
offnet das VNC-Konfigurationsfenster, um das Authenti-
fizierungssystem einzustellen, das Zugangspasswort
zu dndern und so weiter. Achtung: Das Andern der
Parameter wird fortgeschrittenen Benutzern empfohlen;
eine unsachgemaBe Anderung der Parameter fiihrt zu
einer Fehlfunktion des Remote-Desktop-Dienstes. Das
Standardpasswort fiir den Zugriff auf den Remote-Desk-
top des Gerits Giber VNC lautet ,1234",

BACKUP-RESTORE

BACKUP: Verfahren zum Sichern (Upload von HMI) von LogicLab- und Movicon-Projekten.

Nach dem Download der LogicLab- und Movicon-Projekte
auf das Gerédt sowie nach der Konfiguration des Geréts zur
Projektausfiihrung bei jedem Start muss das Gerat aus-
und wieder eingeschaltet werden, indem das Stopp-Sym-
bol gedriickt gehalten wird.

Dies startet das Fenster des TDControlPanel.

Stecken Sie nun einen USB-Stick, formatiert auf FAT32, in
einen der verfligbaren USB-Anschlisse.

Driicken Sie ,BACKUP-RESTORE", um auf das Dienstpro-
gramm zuzugreifen, das die Projekte und die Geratekonfi-
guration sichert.

In diesem Fenster kann gewdhlt werden, welche Ressourcen gesichert werden sollen:

PLC_LOGICLAB (RUNTIME-PROJECT): Sichert das LogicLab-Projekt (und die gesamte Runtime)
sowie die im Fenster ,PLC_LOGICLAB" (erreichbar liber das Hauptfenster des TDControlPanel)
vorgenommene Konfiguration.

HMI_MOVICON(PROJECT): Sichert nur das Movicon-Projekt sowie die im Fenster ,HMI_MOVICON"
vorgenommene Konfiguration (zuganglich iber das Hauptfenster des TDControlPanel).
HMI_MOVICON (RUNTIME): Sichert nur die Runtime.

TdControlPanel (Konfiguration): Sichert die gesamte Konfiguration, die in den verschiedenen
Dienstprogrammen vorgenommen wurde, die Uber das Hauptfenster des TdControlPanel
zuganglich sind. Hinweis: Auf diese Weise wird auch ein eventuelles Zugangspasswort zum TdCon-
trolPanel gesichert, falls es im Fenster ,WIN EXPLORER" eingerichtet wurde.

LAN (IP CONFIGURATION): Sichert die Netzwerkkonfiguration des Gerats.

BOOT SCREEN: Sichert das Hintergrundbild, das beim Systemstart angezeigt wird.

Beim Aktivieren aller Kastchen werden die Konfiguration sowie die im Gerdt enthaltenen Software-
programme vollstandig gesichert. Dies beschleunigt auch die Programmierung mehrerer Bedien-
terminals.
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Durch Driicken der Taste ,BACKUP TO USB DISK” wird der
an das Terminal angeschlossene USB-Speicher gedffnet. Es
kénnen ein Zielordner und der Namen der Sicherungsdatei
ausgewahlt werden (der Standarddateiname ist das Datum
und die Uhrzeit der Erstellung der Datei).

Durch Driicken auf ,OK" startet der Sicherungsvorgang (in
der Mitte des Bildschirms wird eine Sanduhr angezeigt).
Ein Bestatigungs-Popup zeigt das Ende des Vorgangs

an. Durch Driicken von ,OK” wird das Popup-Fenster
geschlossen. Durch Driicken von ,ESC” kann das Gerat
ausgeschaltet werden.

RESTORE: Verfahren zum Wiederherstellen (Upload auf HMI) von LogicLab- und Movicon-Projekten.
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Um ein neues Gerat aus einer Sicherungskopie heraus zu
programmieren, driicken und halten Sie beim Einschalten
das Stopp-Symbol.

Dies startet das Fenster des TDControlPanel.

Stecken Sie nun einen USB-Stick mit der Sicherungskopie in
einen der verfligbaren USB-Anschlisse.

Driicken Sie ,BACKUP-RESTORE", um auf das Dienstpro-
gramm zuzugreifen, das die Projekte und die Geratekonfig-
uration sichert.

Durch Driicken der Taste ,RESTORE FROM USB DISK”
wird der an das Terminal angeschlossene USB-Speicher
gedffnet, und die zuvor erstellte Sicherungsdatei kann
ausgewahlt werden.



Durch Driicken auf ,OK” startet der Wiederherstellung-
svorgang (in der Mitte des Bildschirms wird eine Sanduhr
angezeigt).

Ein Bestatigungs-Popup zeigt das Ende des Vorgangs

an. Durch Driicken von ,OK” wird das Popup-Fenster
geschlossen. Durch Driicken von ,ESC” kann das Gerat
ausgeschaltet werden.

Von nun an startet das Gerdt bei jedem Einschalten automatisch Projekte (und die gesamte
Konfiguration, falls in der Backup-Phase ausgewahlt).

3 LogicLab-Suite (nur HMI+SoftPLC)

LogicLab-Suite ist die Entwicklungsumgebung von Pixsys fiir die Programmierung der SPS PL500 und
der gesamten Serie der Bedienterminals und PanelPCs.

Die Suite kann nach der Registrierung im Downloadbereich von pixsys.net heruntergeladen werden.
Sie erfordert keinen Aktivierungscode. Sie ist kompatibel mit allen Versionen von Windows 32/64bit
ab Windows XP SP3 und ist in englischer und italienischer Sprache verfiigbar. Nach dem Download
der Setup-Datei auf den eigenen Computer kdnnen die Installation gestartet und das Standardver-
fahren befolgt werden. Nach der Installation wird das Programm Uber das Symbol ,LogicLab” @ auf
dem Desktop oder tiber das Menu ,Start” > ,PixsysSuite” > ,LogicLab” gestartet.

3.a  Andern der Sprache

Die Anzeigesprache kann im Optionsfenster Giber
das Meni ,File" > ,Options” gedndert werden. In
der Registerkarte ,Language” kann die italienische
Sprache ,ITA - italiano” markiert und mit ,Select”
gewdhlt werden. Bestdtigen Sie anschlieBend

mit ,OK” und schlieen Sie LogicLab, um die
Anderungen zu iibernehmen.

3.b Erstellen - Laden eines Projekts

Offnen eines bestehenden Projekts:

+ Klicken Sie bei getffnetem LogicLab auf die
Schaltflache ,Open project” oder wéhlen Sie
eines der zuletzt geo6ffneten Projekte aus der
Liste der zuletzt ge6ffneten Projekte aus.

+ Ist LogicLab geschlossen, kdnnen Sie
im Projektordner auf die Datei mit dem
gewlinschten Projektnamen mit dem Symbol
@ und der Erweiterung ,.plcprj” doppelklicken.
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Erstellen eines neuen Projektes:

Driicken Sie die Schaltflache ,New project”.
Geben Sie in dem daraufhin angezeigten Fenster
einen Namen fir das Projekt ein und bestimmen
Sie den Ordner, in dem die Projektdateien
gespeichert werden sollen. Wahlen Sie schlieBlich
das Gerét aus, das Sie programmieren mochten.

YR, Bei Aktivierung der Case-Sensitive-Option ,respect capital/lowercase letters” wird auf die
GroB3- und Kleinschreibung im Variablennamen geachtet. Wir empfehlen daher, diese Option zu
deaktivieren, um Verwirrung beim Schreiben von Programmcode zu vermeiden.

3.c Verbinden mit Zielgerat

Die Voraussetzungen fiir die korrekte Verbindung zwischen dem Zielgerdt (dem zu programmieren-

den Gerat) und der PC-Entwicklungsumgebung (LogicLab) sind Folgende.

Anforderungen an das Zielgerat:

+ Gerat wurde eingeschaltet und gestartet.

+  Gerat ist konfiguriert mit einer statischen IP-Adresse, die mit dem Netz und dem zu verbindenden
PC kompatibel ist. StandardmaBig ist die IP-Adresse der HMI-Terminals 192.168.0.100 und jene
des PL500 192.168.0.99. Der Entwicklungs-PC muss dasselbe Netzwerk und dieselbe Klasse haben
(in diesem Fall 192.168.0.XXX), aber eine andere physische Adresse (d. h. die letzten drei Ziffern
der IP-Adresse, mit einer beliebigen Zahl zwischen 1 und 255, au3er 100). Sollte es erforderlich
sein, die IP-Adresse des Terminals gegeniiber der Standardadresse zu @ndern, lesen Sie bitte die
Beschreibung der Konfiguration des TDControlPanel, Abschnitt ,LAN ETH1*, par. 2.d.

+ Direkte Verbindung zwischen PC und Netzwerkkabel (direkt oder gekreuzt) oder iber einen Netz-
werk-Switch.

+  SoftPLC befindet sich in Ausfiihrung (siehe Beschreibung der Konfiguration des TDControlPanel,
Abschnitt ,PLC LOGICLAB, par. 2.c).

Anforderungen an den Entwicklungs-PC:

« IP-Adresse muss mit dem bestehenden Netz, in dem es sich befindet, und mit der im Zielgerat
konfigurierten IP-Adresse kompatibel sein (siehe vorherige Punkte).

+ Antivirus/Firewall lassen eine Verbindung zu Geréaten im Netzwerk zu (sind in der Regel bereits
korrekt konfiguriert).

+ LogicLab ist so konfiguriert, dass es sich mit dem angeschlossenen Zielgerat verbindet, das
programmiert werden soll: Im Meni ,On Line” > ,Select communication” wahlen, im Fenster auf
die Schaltflache ,Properties” driicken, unter ,IP Address” die IP-Adresse des Zielgerats eingeben
und alle anderen Einstellungen unverdndert lassen. In sehr langsamen Netzen oder bei einer Netz-
konfiguration mit mehreren Switches kann der Timeout-Wert (in mS) erhéht werden.

Die Abbildung zeigt die Standardkonfiguration.

Bestatigen Sie alle Fenster mit ,OK” und speichern Sie iber das Symbol  oder liber das Menu ,File”
> ,SaveProject”.

Um zu Uberprifen, ob die Konfiguration von LogicLab und dem Zielgerat korrekt ist, kann die
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Verbindung tiber das Symbol ¥ oder Gber das Menii ,On Line” > ,Connect” hergestellt werden. Ist
die Verbindung erfolgreich, zeigt die Statusleiste in der rechten unteren Ecke ,CONNECTED” und ,NO
CODE" an (Zielgerat verbunden, kein Code vorhanden) oder ,DIFF CODE” (Code nicht Gibereinstimm-
end mit dem Zielgerate-Code).

3d Kompilieren und Downloaden des Codes

Nach der Eingabe des Projektcodes muss dieser kompiliert werden, um ihn auf Fehler zu tiberprifen.
Dies kann mit der Taste F7, Uber das Symbol & oder tiber das Menu ,Project” > ,Fill” erfolgen.

War die Kompilierung erfolgreich, kann das Programm durch Driicken von F5, iber das Symbol
oder Uber das Meni ,On Line" > ,Code transferring” auf das Zielgerat Gibertragen werden.

In der Statusleiste wird nun ,CONNECTED" und ,SOURCE OK" angezeigt. Das bedeutet, dass das auf
dem Zielgerat laufende Programm mit dem auf dem PC angezeigten Programm tibereinstimmt.

3.e Watch Window

Wenndasim Zielgeratlaufende Programm mitdem auf dem PCangezeigten Programm tbereinstimmt,
werden in der Statusleiste ,CONNECTED" und ,SOURCE OK" angezeigt. Uber das ,Watch Window"
kann der Status der im Projekt verwendeten Variablen in Echtzeit tiberpriift werden. Um das ,Watch
Window" zu aktivieren, drlicken Sie STRG+T oder verwenden Sie das Menu ,View" > ,View tool window"
> ,Watch”. Um eine Variable zum ,Watch Window" hinzuzufligen, ziehen Sie sie einfach hinein oder
driicken Sie auf das Symbol  und wahlen Sie sie manuell aus.

Von nun an zeigt das Watch Window den Wert
der eingegebenen Variable in Echtzeit an.

Uber die entsprechenden Schaltflichen ist es auch méglich, eine bestehende Watch-Liste zu
speichern, zu laden und hinzuzufiigen.

Wenn das Anzeigeformat gedndert werden soll, wahlen
Sie einfach die Variable aus und driicken Sie das Symbol
. Wabhlen Sie in dem nun erscheinenden Fenster das
gewdlinschte Format aus und bestatigen Sie mit ,OK".

4 Verbinden von Movicon 11 und LogicLab (nur
HMI+SoftPLC)

Anmerkung: Movicon 11.5 oder héher erforderlich.

Nur beim ersten Mal durchzufiihren:

Laden Sie auf dem PC, auf dem Sie entwickeln, im Download-Bereich der Pixsys-Website in der Sektion
Movicon die Datei ,MOVICON 11.6 Update-Aggiorna Driver.exe” herunter, welche der Architektur
des verwendeten PCs entspricht. Starten Sie die Datei mit einem Doppelklick und folgen Sie den
Anweisungen auf dem Bildschirm.
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Wird ein Panel-PC (TD750-TD850-TD900-TD910-TD920) verwendet, muss dies auch auf dem Panel-PC
erfolgen. Pramisse: Mit diesem Verfahren werden alle SPS-Systemvariablen und alle im SPS-Projekt
erstellten und verwendeten Variablen importiert.

Die Erstellung und Aktualisierung der SPS-Variablenliste erfolgt nur, wenn das LogicLab-Pro-
gramm fehlerfrei kompiliert und auf das Zielgerat geladen wurde.

4.a Erstellen eines neuen Movicon-Projektes

Starten Sie die Software und wahlen Sie die Plattform ,Windows® X86 / X64" fur Panel-PCs und
Windows® CE” fiir HMIs und die PL500-Version ,WEB". Wenn ein neues Movicon-Projekt mit Hilfe des
Assistenten erstellt wird, erscheint am Ende das Treiberkonfigurationsfenster, weshalb direkt zum
Abschnitt ,Treiberkonfiguration”, par. 4.b Ubergegangen werden kann. Wenn Sie den Treiber manuell
installieren, folgen Sie hingegen den nachsten Schritten.

Fligen Sie den Kommunikationstreiber hinzu,
indem Sie mit der rechten Maustaste auf ,Real
time DB" und dann auf ,New communication
driver” klicken.

Waéhlen Sie ,Pixsys” aus dem Herstellermenii
und dann ,Pixsys SoftPLC Driver”.

Bestatigen Sie mit ,OK" und doppelklicken

Sie auf den neu erstellten Treiber, um das
Konfigurationsfenster zu 6ffnen.

4.b Konfigurieren des Treibers

Wabhlen Sie die Registerkarte , Station” und
figen Sie mit der Schaltflache ,ADD" eine neue
Station hinzu.
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1. Geben Sie den Quellpfad des LogicLab-
Projekts auf dem PC ein, um Variablen zu
importieren und Moviconim Preview-Modus
auf dem PC auszufiihren, einschlie3lich
Uberpriifung der Kommunikation mit
SoftPLC. Hierfir wird im nachsten Schritt
die IP-Adresse des zu programmierenden
Terminals angegeben (erst nach erfolgter
Entwicklung wird die Localhost-Adresse
127.0.0.1 eingegeben, damit das Movicon-
Projekt mit SoftPLC auf demselben Rechner
kommuniziert).

4.

. Dieses Feld wird nach der Eingabe des Pfades in Schritt 1 automatisch kompiliert: Bei Verwendung
von HMIs und PL500 darf das automatisch kompilierte Feld nicht verdndert werden. Bei Panel-PCs
(TD750-TD850- TD900 etc.) geben Sie den Pfad an, in dem das LogicLab-Projekt heruntergeladen
wurde (standardmaBig D:\LLExec\ NameMyProjectLogicLab.sym.xml).

. Wird die Movicon-Anwendung auf dem Panel-HMi oder dem Panel-PC ausgefiihrt, auf dem sich
auch SoftSPS befindet, geben Sie die IP-Adresse 127.0.0.1 ein. Wird Movicon hingegen auf einem
anderen Panel-HMi oder Panel-PC als jenem von SoftPLC betrieben, muss die IP-Adresse von
SoftPLC angegeben werden.

Geben Sie in unter ,General” einen Namen fir die Station, z. B. ,PLC".

Driicken Sie OK, um die Einstellungen zu speichern und den Vorgang zu beenden.

Nun kdnnen die Variablen des LogicLab-Pro-
jektin Movicon importiert werden.

Klicken Sie mit der rechten Maustaste auf
,Pixsys SoftPLC" und wahlen Sie ,,/mport PLC
database”.

Klicken Sie auf die Schaltflache ,Read from PLC
project”; die Liste der verfligbaren Variablen
wird angezeigt.

Waihlen Sie dann die Variablen aus, die Sie
importieren mochten. Klicken Sie auf die
Schaltflache ,Import”.

Anmerkung: Beim Importieren einer Array-Variable wird diese als Struktur mit dem Namen des
Arrays angezeigt. Auf die Array-Elemente kann einzeln mit der Syntax NameMyArray:NameMyArray_X
zugegriffen werden. X ist der Index des Arrays (beginnend bei 0). Die Variablen sind jetzt im Movicon-
Projekt verfiigbar. Sollen neue Variablen importiert werden, z.B. nach einer Anderung des LogicLab-
Projektes, wiederholen Sie einfach das Verfahren zum Lesen und Importieren der Variablen.

4.c

Ubertragen von Movicon-Code in das Zielgerit

Das Ubertragen des Movicon-Projekts erfolgt mit dem Symbol:
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1. Wihlen Sie das Ubertragungsprotokoll: TCP.

2. Geben Sie die IP-Adresse des Zielgerdts ein
(Standard fir HMI/SPS: 192.168.0.100).

3. Lassen Sie bei Verwendung von HMI/SPS das
Feld leer, geben Sie bei Panel-PCs ,user” ein
(oder den Namen des im Zielgerat-Panel-PCs
angemeldeten Benutzers).

4. Lassen Sie bei Verwendung von HMI/SPS das
Feld leer, geben Sie bei Verwendung eines
Panel-PCs 123456 ein.

5. Geben Sie bei Verwendung von HMI/SPS \
NandFlash\MyMoviconProjectName\ ein, geben
Sie im Falle eines Panel-PCs D:\MyMoviconPro-
jectName\ ein. Movicon erstellt einen Ordner mit
dem Namen MyMoviconProjectName und ladt
alle Projektdateien in diesen Ordner herunter.

6. Driicken Sie auf die Schaltflache ,Upload Project”,
um die Ubertragung zu starten (driicken Sie auf
JYes to All”, falls Sie bereits ein Projekt herunter-
geladen haben und es iberschreiben méchten).

7. Nach Beendung des Downloadvorganges
klicken Sie auf ,Start Device Project”, um das
Projekt auf dem Zielgerdt auszufiihren (das
laufende Projekt wird beendet und das zuletzt
Ubertragene Projekt wird gestartet).

Anmerkung: Wenn mehrere verschiedene Projekte/Versionen lbertragen werden sollen, andern Sie
einfach den Zielordner (der erste Teil \NandFlash\ muss jedoch beibehalten werden). Im TdControlPa-
nel muss ausgewdhlt werden, welches Projekt aus dem Gerétspeicher beim Einschalten des ZielGerats
automatisch gestartet werden soll (siehe Abs. 70.b).

5 Simulieren des gesamten SoftPLC-SCADA-Projekts (nur
HMI+SoftPLC)

Starten Sie den Simulatorin LogicLab liber das Symbol = oder Giber das Men( ,Debug” > ,Simulation
mode”. Erstellen Sie im visualisierten Fenster einen neuen Arbeitsbereich und geben Sie den Namen
und Zielordner an (standardmaBig ist der Ordner ausgewahlt, in dem sich das Projekt befindet).

Der Simulator wird gestartet und verbunden (das Statusfenster zeigt den Status ,CONNECTED" an),
aber ohne Code (das Statusfenster zeigt den Status ,NO CODE" an). Ubertragen Sie den Code durch
Driicken der Taste F5, Giber das Symbol  oder Uber das Menui ,Online” > ,Online download code”.
Vergewissern Sie sich, dass in der Statusleiste ,CONNECTED" und ,SOURCE OK" angezeigt werden. Wird
immer noch ,NO CODE" angezeigt, starten Sie den Simulator neu (iber das Symbol # oder Meni
.Online" > ,Target reboot").

Rufen Sie in Movicon das Konfigurationsfenster des Pixsys-Treibers auf und konfigurieren Sie es wie
folgt:
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3.

4,

. Geben Sie den Ordner an, in dem sich

das LogicLab-Projekt befindet; wahlen
Sie die Datei NameMyProjectLogicLab.
sym.xml.

. Geben Sie den Ordner ein, in dem der

Simulator arbeitet, setzen Sie den Datei-
typfilter auf ,All files (**)" und wahlen Sie
die Datei NameMyProjectLogicLab.sym.
simul. Achten Sie auf die Dateierweite-
rung, da im Projektordner viele Dateien
mit demselben Namen, aber unter-
schiedlichen Erweiterungen existieren.
Legen Sie die Localhost-Adresse fest:
127.0.0.1.

Geben Sie unter ,General” einen Namen
fur die Station ein, z. B. ,SPS".

Um die Simulation der grafischen Benutzeroberflache zu starten, die mit dem Simulator verbunden

ist (der bereits den zuvor heruntergeladenen Code ausfiihrt), driicken Sie Alt+F12, das Symbol  oder

das Menti ,File" > ,Start Project”. Um die Simulation zu beenden, driicken Sie Alt+F12 oder das Symbol
in der oberen Leiste.
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Beschrankte Haftung

Pixsys S.r.l. garantiert seine elektronischen Geréte fiir einen Zeitraum von 12 Monaten ab Rechnungs-
datum. Die Herstellergarantie ist begrenzt auf die Reparatur oder den Ersatz von Teilen mit Fabri-
kationsfehlern, die unter Angabe der Riicksendenummer (internes RMA-Autorisierungsverfahren)
an unser Haus zuriickgesandt werden. Pixsys haftet nicht fur Unfdlle/Schadensfélle und Personen-
oder Sachschaden, die infolge von Manipulation (einschlie8lich Reparaturversuchen durch nicht
autorisiertes Personal) oder aufgrund von ungeeigneten Umgebungsbedingungen, unsachgemafer
Installation oder durch falschen, unsachgemafB3en oder jedenfalls durch einen nicht mit den in der
technischen Dokumentation angegebenen Eigenschaften des Geréts konformen Gebrauch entstehen.
Unter keinen Umsténden geht die Haftung des Herstellers tiber den Wert des Geréts hinaus. Die
Garantie deckt in keiner Weise Probleme ab, die sich aus der Installation von Softwareprogrammen
nach dem Verkauf ergeben, und insbesondere keine Schaden, die durch die Ausfiihrung von Malware
entstehen. Fir jede Supportleistung von Pixsys zur Wiederherstellung des Betriebssystems oder der
Programme wird die geltende Supportgebiihr verrechnet.

Anmerkungen / Updates
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Read carefully the safety guidelines and programming instructions contained in this manual
before using/connecting the device.

Prima di utilizzare il dispositivo leggere con attenzione le informazioni di sicurezza e settaggio
contenute in questo manuale.

Vor Verwendung des Gerétes sind die hier enthaltenen Informationen beziiglich Sicherheit und
Einstellung aufmerksam zu lesen.

CE€ |owshr g
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PIXSYS s.r.l.

WWW.pixsys.net
sales@pixsys.net - support@pixsys.net

online assistance: http://forum.pixsys.net

via Po, 16 1-30030
Mellaredo di Pianiga, VENEZIA (IT)
Tel +39 0415190518
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